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Installing i-cut

Before installation of i-cut software can begin, you must first complete the following:

Install the Epix® PIXCI® Video Capture Board into an unused PCI slot
in your computer.

Make sure all Motherboard drivers for your PC are installed.

Connect your i-cut dongle to an available USB port.

Connect the plotter and vision system to your computer.

Log onto your Windows® operating system administrator account.

Insert the i-cut installation disc in your CD-ROM compatible drive.

Installing i-cut requires adding the following software components to your system:

Epix PIXCI Video Capture Board Driver

HASP® copy protection support

i-cut main program

Adobe® Acrobat® reader

XL/XE-Guide machine control software (Kongsberg users only)

KAVO spindle control software (Kongsberg users only)

To install the Epix PIXCI Video Capture Board Driver:

As mentioned above, please make sure the Epix Video Capture Board is 
installed into an available PCI slot in your computer and the installation disc 
is inserted into your CD-ROM drive.

Windows will detect your new hardware the first time you log on after 
installing it. Follow the instructions in the Add Hardware Wizard to 
continue installing the driver. If your new hardware is not automatically 
detected, double-click the Add Hardware icon in the Control Panel.

After the wizard has finished searching for new hardware, it will ask: 

“Can Windows connect to Windows Update to search for software?” 
Activate No, not at this time and click Next to continue.

In the next window, activate Install from a list or specific location (Advanced) 

•

•

•

•
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and click Next to continue.

Then, activate Search for the best driver in these locations. Also activate Include this 
location in search: and Browse to the folder corresponding to your operating system 
(Windows 2000 or XP) in the Epix folder on the i-cut installation disc.

The wizard will notify you that “The software you are installing....has not passed 
Windows Logo testing....” Select Continue Anyway and Finish in the following 
window to close the wizard.

The Epix PIXCI Video Capture Board Driver is now installed. You may  be prompted 
to restart your computer, it is recommended that you do so. If the driver does not properly install, an error will be 
produced when the vision registration system is utilized. The -43 error indicates that there is an issue with the driver and 
i-cut is unable to access the Epix card. To correct this error, re-install or update the driver from the Device Manager. The 
-1 error indicates that there is an issue with Windows DirectX® communication and is most often a result of absent or 
incorrectly installed Motherboard drivers. To correct this error, re-install the drivers (from the manufacturer’s disk supplied with your 

computer), and restart your system. 

Installation Note for i-cut Esko®-Kongsberg® users:

As stated above, additional software components are required to operate your system. To simplify your installation process, 
we have created the i-cut Multi-Installer, which is now included in the 6.2 Full Install for Kongsberg Users. The Multi-
Installer provides an interface with installation and setup instructions for your system, as well as buttons for installing the 
various software components directly from the interface. In addition to the Multi-Installer, installation instructions for 
Kongsberg cutting tables are incorporated into the instructions below.

To install HASP Copy Protection Support and the i-cut Application:

Insert the i-cut installation disc into your CD-ROM compatible drive. The i-cut installation 
or Multi-Installer (Kongsberg users only) should start automatically after a few moments. If either 
does not start, explore the installation disc and manually launch the installer. If you are 
installing from a downloaded installation package, explore the package and manually launch 
the installer or Multi-Installer by double clicking the respective file.

Kongsberg Users should click the Install i-cut button on the right side of the 
Multi-Installer. All other users should proceed directly to step 3.

Activate the i-cut main program and HASP copy protection support options to 
install both components onto your system. If you have previously installed 
i-cut, it may not be necessary to re-install HASP copy protection support. 
Click Continue to begin the installation.

After HASP copy protection support has finished installing, the i-cut
installation wizard will launch automatically.

Click Next to continue the installation process.
Carefully review the license agreement, activate I Agree and click Next to 
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proceed. The wizard will not allow you to continue the installation until 
you agree to the terms in the license agreement.

Designate an installation folder. If you want to review your available disk 
space before installation, click Disk Cost. You must also assign whether the 
installation is for all users (Everyone), or for only the administrator (Just me).
Click Next to continue.

Click Next on the remaining screen. Once installation is complete, click 
Close to exit the wizard.

To install Adobe Acrobat reader:

Kongsberg Users should click the Install Acrobat button on the right side of
the Multi-Installer. All other users should explore their i-cut Installation CD or downloaded installation package and 
locate the acrobat folder. Open the folder and double-click the AdbeRdr708_en_US.exe file.

Follow the instructions in the Adobe installation to complete the Acrobat install.

At this point, you have completed the installation of i-cut. Kongsberg Users should continue on to install the additional 
required software components.  To all other users, you should restart your computer before beginning the i-cut
configuration process. Running the installation wizard again will allow you to repair or remove i-cut from your system. 
The next part of this manual covers proper configuration of XL/XE-Guide. Non-Kongsberg users should skip ahead to 
Part 3, Configuring i-cut.

To configure ports (Kongsberg users only):

If you are re-installing or upgrading an existing i-XL/i-XE system, you should skip this section entirely. If you are
installing the system for the first time, or onto a new computer this section will guide you through configuring your ports. 
Your computer’s ports must be configured properly before communication between XL/XE-Guide and your cutting table 
can occur. Read each step carefully before moving on. Once you have read and understand the necessary steps, click the 
button on the right side of the Multi-Installer to open your computer’s Device Manager.

For i-XL FlexiHEAD and i-XE Users:

Open the Device Manager and expand the Ports (COM & LPT) 
devices by clicking the corresponding + symbol.

Locate Communications Port (COMx) and right-click it using 
your mouse. Select Properties from the right-click menu. In the 
Communications Port Properties window, click on the Port Settings
tab, then click the Advanced... button.

Select COM1 from the COM Port Number: drop-down box. Click 
OK to return to Communications Port Properties.

Now select 38400 from the Bits per second: drop-down box. Click 
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OK to return to the Device Manager.

This completes the ports configuration for i-XL FlexiHEAD and i-XE users, you should close the Device Manager.

For i-XL MultiCUT Users:

First make sure you have installed the USB-to-Serial adapter that was included with your cutting system. The adapter 
adds another serial port to your computer and is required to operate i-XL systems with the MultiCUT tool head.
Follow the adapter’s included instructions to complete the installation.

Locate the USB-to-Serial adapter in the Ports devices and right-click it. Select Properties from the right-click menu. 
In the Communications Port Properties window, click on the Port Settings tab, then click the Advanced... button.

Select COM1 from the COM Port Number: drop-down box. Click OK to return to Communications Port 
Properties.

Now select 38400 from the Bits per second: drop-down box. Click OK to return to the Device Manager.

Locate Communications Port (COMx) and right-click it using your mouse. Select Properties from the right-click menu. 
In the Communications Port Properties window, click on the Port Settings tab, then click the Advanced... button.

Select COM2 from the COM Port Number: drop-down box. Click OK to return to Communications Port
Properties.

Now select 38400 from the Bits per second: drop-down box. Click OK to return to the Device Manager.

This completes the ports configuration for i-XL MultiCUT users, you should close the Device Manager.

To install XL/XE-Guide (Kongsberg users only):

This section will guide you through the installation of XL-Guide or XE-Guide. Read each 
step carefully before moving on. Click either the INSTALL XL-Guide or INSTALL XE-Guide
button on the right side of the Multi-Installer to install the corresponding machine control 
software. i-XL 20, 24 and 44 customers should install XL-Guide, while i-XE 10 customers 
should install XE-Guide.

Make sure the cutting table is powered off and, if you are upgrading, your 
current version of XL/XE-Guide is not running. Turn on the power switch 
located on the i-XL/XE control panel, but DO NOT launch XL/XE-Guide (if 
previously installed).

Follow the Instructions displayed by the Setup program until you’re asked 
to “Load CU - modules now?” Click Yes to continue and Yes again when 
asked to “Load all modules?” Once the Program Load dialog is displayed 
wait for the CU descriptions to appear in the window, then click Load. The
CU loading process could take several minutes. When finished, you will see 
updated descriptions in the progress dialog. Closing the dialog will complete 
the program setup.
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To install KAVO (Kongsberg users only):

Installation of KAVO spindle control software is necessary only if you 
purchased the MultiCUT tool head with your i-XL system. It is not required 
if you have an i-XE system, or if your i-XL system was purchased with a 
FlexiHEAD only. Read each step carefully before moving on. To begin the 
installation, click the button on the right side of the Multi-Installer.

Click OK to begin the installation and click OK again to continue.

When the COM port selection dialog appears, select COM2 and click 
OK to continue and OK to any other dialogs.

You may see a security warning stating that “The Publisher cannot be verified.” You should click Continue Anyway to 
disregard the warning and click OK to any remaining dialogs to complete the installation.

At this point, you have completed the installation of i-cut and all necessary supporting software components. You should 
restart your computer before beginning the i-cut configuration process. Kongsberg XL/XE-Guide machine control 
software must be configured before configuring i-cut. Kongsberg users should read the next part of this manual, which 
covers proper configuration of XL/XE-Guide. All other users should skip ahead to Part 3, Configuring i-cut.

1.

2.

3.



12

Configuring XL/XE-Guide

Kongsberg i-XL & i-XE users must configure their XL/XE-Guide machine control software before configuring i-cut.
Initial configuration of any i-XL/i-XE system should be performed by a certified installation technician. If you are an end-
user of the machine, these instructions are meant to help you re-install or upgrade your professionally installed system.

To start XL/XE-Guide:

Toggle the power switch Off and back On, then launch XL/XE-
Guide from the desktop icon, or from the Windows Start menu.
The orange indicator light on top of the tool head will begin to 
flash. Follow steps 2 through 4 to home out the cutting table.

Press the red Stop button located on the lower right corner of the 
Kongsberg control panel. The orange indicator light should stop 
flashing. If it does not, make sure the black dots on the safety 
guards on both sides of the traverse are aligned and press the Stop 
button again. Once the light is no longer flashing, go to step 3.

Now press the Servo Power button located on the upper left corner 
of the Kongsberg control panel. This turns on the machine’s servo motors. The red LEDs next to the Servo Power 
button, and Home button (just above the green Start button) will illuminate. When they do, proceed to step 4.

Press the green Start button. The tool head will move to the corner closest to the operator’s station. When it stops, 
the machine is homed out and ready for configuration.

To register table size:

Open the Table Options window by selecting Table options... from the Options pull-down menu.

Click the Register table size button.

Follow the instructions in the Register table size window to register the table size. The 
cutting table will move the tool head around the limits of the table and return to the 
corner closest to the operator’s station. When it stops, click the Close button to complete 
the procedure.

To set table top reference:

Setting the Table top reference allows XL/XE-Guide to measure the height of the table top.

Open the Table Options window by selecting Table options... from the Options pull-down 
menu.

Using the jog buttons on the Kongsberg control panel, move the tool head to a clean, 
empty area of the table.
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Click the Table top reference button.

Follow the instructions in the Table top reference window to perform the measurement. The tool head will lower 
the measuring foot to the table surface and then raise it. When complete, click the Close button to complete the 
procedure.

To map the table top surface:

Mapping the table top surface allows XL/XE-Guide to correct for surface height differences while cutting. This advanced 
feature makes it possible for your i-XL or i-XE system to accurately maintain cutting depth regardless of minor 
imperfections on the cutting surface. Mapping of the table top requires the cutting table to measure the surface height in 
many locations, and takes 5 to 15 minutes to complete depending on table size.

Open the Table Options window by selecting Table options... from the Options pull-down menu.

Click the Map table top surface button.

Follow the instructions in the Mapping table surface window to Map the table top surface. The cutting table will start 
taking height measurements across the front of the table and work its way back. When it reaches the back of the table 
and stops, click the Close button to complete the procedure.

To set reference points:

Open the Table Options window by selecting Table options... from the 
Options pull-down menu. 

Click the Set reference points button.

In the Set reference point window, click the i-cut Main reference button.

Click Finish.

To configure vacuum control:

Open the Table Options window by selecting Table options... from the 
Options pull-down menu. 

In the Vacuum control section, activate the i-cut controlled checkbox.

Click the System tab at the top of the Table Options window.

Now click the Vacuum Setup... button, located in the Vacuum section at the bottom of the 
System Options window.

From the Vacuum Setup window you are able to select the vacuum configuration that best 
matches your table’s hardware. If your table is configured with 3 zones, you should select 
configuration #8. If you have 4 zones, you should select #11.
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After selecting the appropriate zone configuration, click OK to close the window.

To set the jog panel direction:

Open the Table Options window by selecting Table options... from the Options 
pull-down menu. 

Click the Speed setup tab at the top of the window.

From the Jog panel direction drop-down box, select 90 degrees - Std i-XL/XE.

Click Apply, then OK.

This completes the initial configuration of XL/XE-Guide. i-cut 6.2 allows direct 
access to the key features XL/XE-Guide, making it unnecessary for users to work with 
XL/XE-Guide on a regular basis. Follow the instructions in part 3 of this manual for 
starting and using your system after i-cut has been configured. 

6.
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Configuring i-cut

Once installation is completed, i-cut may be opened for the first time. Make sure 
your i-cut dongle is plugged into one of your computer’s USB ports. Launch the 
program from the Windows Start menu (Program Files\MGE\i-cut). Upon opening 
for the first time, i-cut will display the Schedule Backup window. Selecting one 
of the three available options will dictate how often i-cut backs up all critical 
settings, including tools, production options, system options, etc... Activating 
the Backup Silently check box will cause the system to perform backups without 
first prompting the user. The backups themselves take only a second or two. 
Make a selection and click OK to continue.

i-cut Setup Wizard

After you have selected a scheduled backup option, and closed 
the Schedule Backup window, the i-cut Setup Wizard will appear 
automatically. The Setup Wizard provides several standard configurations 
for the most popular and widely used i-cut integrated cutting devices. 
Find your device by selecting the manufacturer from the Collections 
drop-down box and the model from the Configuration window. The 
Explanation section provides important details about the configuration 
you have chosen. Kongsberg users should make sure their cutting table 
is turned on before selecting a standard configuration.

Advanced Setup

If your cutting system is not included in the standard configurations, or if you prefer to set up i-cut manually, the Setup 
Wizard provides an advanced setup that walks you through system setup one dialog at a time. It is highly recommended 
that you use a standard configuration if available. Below you will find further explanations and additional information 
for each setup dialog that is included in the advanced setup.

System Options

i-cut’s System Options window is the first dialog presented by the Setup Wizard. After setup is complete, this 
window may be accessed at any time from the Options menu.

Plotter Type:  The Plotter Type section provides a drop-down list of supported cutting devices, as well as the 
corresponding X/Y dimensions of each device. Select the plotter type that best matches your cutting device
from the list. If your device provides a function that measures the actual X/Y dimensions of its cutting area, 
you should replace the default values in the plotter type section with your actual measured dimensions. Doing 
this will ensure that i-cut is utilizing your plotter’s total cutting area. Kongsberg users should not enter any 
X/Y dimensions, as they are communicated directly from XL/XE-Guide to i-cut. Kongsberg users should also 
make sure their cutting table is turned on before selecting a plotter type.

Units:  In the Units section, you are able to select which system of measurement you would like to use.

•

•
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Activate Inches or mm (millimeters). If you are generating files with i-script, you should set the units according 
to your RIP software’s output. Failure to do so may result in improper scaling when the files are opened in 
i-cut.

Import Units:  Import Units defines the system of measurement i-cut will apply to the units of imported files. 
Activate Inches or mm. Ideally, the import units should be set to the same type as the working units in your 
vector-based design software. This will prevent any possible scaling issues with imported files.

Speed Units:  Selecting one of the available Speed Units options from the drop-down box determines the 
units used for setting velocity in the i-cut user interface.

Tolerance:  The Tolerance When Producing parameter sets the tolerance at which i-cut will produce 
optimized curves. The default value of 0.020 mm (0.0008 in) is sufficient in almost all instances. It is highly
recommended that you do not change this value.

Settings:  Step X-axis before Y-axis - This setting affects the order in which i-cut produces multiple steps in
both the X and Y axis. When activated, i-cut will produce the entire column (Y) before moving onto the next 
row (X). Leave this setting unchecked for now; the default setting is preferred in most instances.

Furthest Regmark First - Enabling this option will tell i-cut Vision to read the register mark in the furthest 
X position first, then read the rest of the register marks normally. Doing this helps i-cut calculate placement 
and rotation of curves on large sheets, but will also increase the register mark read time. Check this setting 
now. If you would like to trade some precision for added speed, you can come back and disable this option 
at any point.

Disable Undo System - If you installed i-cut on an older computer, activating this option could increase 
system performance. Disabling the undo system will speed up the user interface and decrease the memory 
requirement, but is not recommended.

Import Options:  The Import Options determines how i-cut will format imported curves.

•

•

•

•

•
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Connect open curves allows you to close open curves automatically on import. The Threshold value sets the 
maximum distance between the start and end point for closing to occur.

Reject small Curves provides a useful tool for cleaning up unwanted curves and stray points. The Threshold 
value sets the maximum size of a curve for rejection.

Set Curve Direction after Import assigns a common curve direction, for consistent cutting results and 
simplified file preparation in i-cut. Activating Invert direction for inside curves alternates the direction of 
inner-nested curves.

Move to (0,0) after import moves the contents of an imported file to 0,0. Familiarize yourself with these 
options, but leave the default settings intact.

Production Options

A production option is a string of commands that i-cut sends to the 
cutting device each time you produce a job. i-cut’s Production Options 
window is the next dialog presented by the Setup Wizard. After setup 
is complete, it may be accessed at any time from the Options menu. 
The Production Options window displays all production options (.opt 
files) currently located in the \\MGE\i-cut\Prod folder. From this 
window, you can create or load new production options, as well as 
copy, delete and edit existing options. i-cut installs with several default 
options that are suitable for most scenarios, but can also be customized 
to meet your specific requirements. These default options are located 
in the \\MGE\i-cut\Prod Options\your plotter type folder. To load
them, use the Load feature. Select one of the production options and 
click Edit to view its string of commands, but don’t make any changes 
to the string at this time.

Locator

The Locator window is the next dialog presented by the Setup Wizard. Locator options affect how i-cut utilizes its 
locator device (camera). Some cutting devices may require assigning a specific pen number for the locator. Leave 
the default value of 1 intact, unless you are instructed otherwise by 
MGE technical support. If you are using a MultiCAM Router, make 
sure the Use Select Pen (SP) before Locator option is unchecked. 
The other parameters in the Locator window should remain at 
their default settings. i-cut defaults these parameters correctly for 
all currently supported cutting devices. After setup, the Locator 
window may be accessed at any time from the Options menu.

Some new options were added for Zünd users in i-cut 6.2. Support 
for an alternative select pen command (requires new Zünd firmware) is 
available by Activating the Use Alternative Select Pen with Locator 
option. This alternative command provides faster changes between 
tool positions in multi-tool productions. Also supported is the 
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Zünd camera, which has a brightness control option. To utilize this option, activate the Manage Camera Lighting 
option and set the slider to the desired brightness.

Plotter Connection

i-cut currently communicates with many supported cutting devices through 
a standard Serial/RS-232 connection. However some devices, such as the 
Esko Kongsberg i-XL & i-XE cutting tables, AXYZ® Routers and i-cut
GraphicsRouters™ are driven through software communication. If you 
have selected one of these devices from the System Options window, or 
by selecting a standard configuration, configuring the plotter connection 
is unnecessary and the window will not be displayed by the Setup Wizard. 
In the Plotter Connection window, you are able to adjust the parameters of 
your connection. The PortNo value tells i-cut which COM port number is 
assigned to the connecting serial port. This should be verified in the Ports 
section of your computer’s Device Manager. The remaining parameters should be set to reflect the corresponding 
values set or defaulted in your plotter. After setup, the Plotter Connection window may be accessed at any time 
from the Options menu.

File Locations

The next dialog presented by the Setup Wizard is the
File Location window. Defining file locations will 
reduce the amount of time spent browsing for files.
After setup is complete, the File Location window may 
be accessed at any time from the Options menu. i-cut
allows you to set file locations for three types of files; 
they are: Jobs (.Cut files), Import (.ai, .dxf, .pdf and 
.hpgl files) and Tools (.tool files). The Apply section 
provides three additional options. When For each File 
Access is selected, all load/save dialogs will start in the 
folders specified. When Starting i-cut will remember 
the last folder used for each file type, as long as the program is running. Every time you launch i-cut, the locations 
specified in this window are restored. When Leaving this Dialog will cause the folders specified to be applied only 
once. If you choose another folder from a load/save dialog, it is remembered (even if you exit and re-launch the 
program).

Jobs:  Set this file location to a folder on your system drive or network that you will use to store your saved 
i-cut files. If you are generating .Cut files using i-script and retrieving them manually (without barcoding), 
you should set the file location to the .Cut file output folder designated in your RIP software.

Import:  The Import file location is accessed to retrieve the .ai, .dxf, .pdf and .hpgl files generated by your 
vector-based design software. You should designate a folder on your network that is accessible by both your 
digital artist/art department and the computer attached to your cutting device.

Tools:  All .tool files are normally stored in a designated tools folder, for your plotter type, on the system 

•

•

•
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drive. Set the file location to: \\MGE\i-cut\Tools\your plotter type. Esko-graphics 
Kongsberg i-XL users do not need to set up a Tools file location. i-cut communicates 
with Kongsberg’s i-XL/XE Guide software and displays all available tools from XL/XE
Guide’s tool setup.

Language

The language of the i-cut interface defaults to the Windows operating system language. If 
your current Windows language is not supported by i-cut, or you prefer to select a different 
language; you may change the current setting in the Language window. After setup, this 
window may be accessed at any time from the Options menu. Activate the desired language 
and click OK. The new language setting will not take effect until you restart i-cut.

Configuration

This is the last dialog presented by the Setup Wizard. The Configuration 
window displays all the options currently activated on your HASP 
dongle. If your i-cut dealer supplied you with a control word, you 
should enter it in the Control Word field and click Add. Doing so will 
update your dongle’s configuration and newly enabled options will 
appear in the list. Be sure to enter the control word exactly as it was 
issued to you. If possible, copy and paste the text to avoid mistakes.
In addition, the window displays your HASP ID number (dongle 
number). You will need to know your dongle number in the future 
when upgrading your system. Occasionally it may be necessary to 
upgrade your dongle configuration if you are upgrading from an older 
version of i-cut, adding features to your existing version or extending 
the dongle time limit. After setup, the Configuration window may be 
accessed at any time from the Options menu.

After you have finished setting the parameters in all dialogs click Finish to
close the Setup Wizard. To ensure that all new settings take effect, it is recommended that you close and re-launch i-cut.
Continue on to the next section for further instructions on starting your i-cut system. It is also recommended that you 
restart your cutting device before continuing.

Starting i-cut

These procedures should be followed whenever starting your i-cut system:

For Kongsberg i-XL/XE Users

Toggle the power switch Off and back On, then launch i-cut from the desktop icon, or from the Windows 
Start menu. The orange indicator light on top of the tool head will begin to flash. You will see the XL/XE-
Guide interface appear. Do NOT use the software or any of its features at this time.

1.
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Press the red Stop button located on the lower right corner of the Kongsberg control panel. The orange 
indicator light should stop flashing. If it does not, make sure the black dots on the safety guards on both sides 
of the traverse are aligned and press the Stop button again.

Now press the Servo Power button located on the upper left corner of the Kongsberg control panel. This turns 
on the machine’s servo motors. The red LEDs next to the Servo Power button, and Home button (just above 
the green Start button) will illuminate.

Press the green Start button. The tool head will move to the corner closest to the operator’s station. When it 
stops, i-cut will start automatically.

For all other Users

Make sure your cutting device is turned on and follow any additional startup procedure instructions provided
with your device.

Launch i-cut from the desktop icon, or from 
the Windows Start menu. i-cut will start 
automatically.

Take a few moments to familiarize yourself with i-cut’s 
user interface. This same interface is used to control many 
different types of cutting devices and provides several 
powerful tools in a simple and easy to use layout.

Customizing the User Interface

The first section of the View menu provides options for 
customizing the user interface. With these options, you are 
able to turn various interface components on/off, as well as 
define the split position between the main window and the 
Layers palette.

Toolbars:  This option allows you to turn on/off the standard i-cut toolbar, which 
provides quick access to many important features. Kongsberg users will see an 
additional toolbar option called the Kongsberg toolbar, which provides quick 
access to additional features specifically for controlling Kongsberg cutting tables. 
For more information on the Kongsberg toolbar, refer to the Advanced Production 
part of this manual. By left-clicking, holding and dragging either toolbar away 
from its default position, it becomes a floating palette that can be re-positioned 
anywhere over the interface.

Status Bar:  Turning on this option will display important information in a bar at 
the bottom of the interface.

Split:  This option allows you to re-position the split between the main window 
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and the Layers palette. Defining the split directly from the 
main window is achieved by using the mouse to drag the 
divider left or right.

Ruler:  Turning the Ruler on will display units for measuring 
along the left side and bottom of the main window. The 
Ruler is provided for visual reference when working with 
jobs.

Editing Tools

An i-cut tool (.tool file) is a set of parameters associated with
a physical tool used by your cutting device. All tool editing is 
performed in the Edit Tools window, which is accessed from the 
Edit menu. By activating the relative options to control your 
tools, and setting the default parameters for those options, you 
will be able to easily select and configure tools when setting up 
jobs.

Loading Tools

For Kongsberg i-XL/XE Users:  Each time you launch i-cut, it updates the available tools based on information 
it receives from XL/XE-Guide. This communication tells i-cut exactly which tools have been installed with your 
i-XL/XE system. There is no reason for you to create or load tools, but you are able to remove tools with the 
provided button. Removing a tool only removes it from i-cut, which means the tool will re-appear next time you 
launch the program. Read the section below, entitled “Editing Kongsberg Tools” for information on permanently 
removing tools from your system.

For all other Users:  i-cut installs with default .tool files for many different supported cutting devices. If you 
selected a standard configuration from the Setup Wizard, you will see that several tools are already available from 
the Tool drop-down box. These preloaded tools are configured with the most common options. To load other 
default tools, click the Load Button. If you already set the tools file location, i-cut will automatically open the 
correct tools folder. If not, browse to \\MGE\i-cut\Tools\your plotter type. Select the tool you would like to load 
and click Open. The tool you selected now appears in the Tool drop-down menu. Repeat this procedure until you 
have loaded all desired tools. Notice that you can also add new tools, save changes to .tool files and remove tools. 
It is recommended, however, that you do not remove any of i-cut’s default tools.

Editing Tool Parameters

The Generate code for section of the Edit Tools window (bottom) provides several common tool parameters for
the selected tool. If you already loaded a tool, or if you selected a standard configuration in the Setup Wizard, you 
will see some of these parameters are activated and their initial values are set. These defaults represent the normal 
functionality of the default tools.

You can activate other options or modify the initial values, but remember to make logical selections when 
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activating parameters. For example, you should not activate Laser Power when setting up a router tool, or Tool 
Offset when setting up a knife tool. Also, some common parameters may not be supported by your cutting device. 
As an example, i-cut displays a Spindle RPM parameter, but this parameter is not supported by Zünd cutting 
plotters, and therefore should not be activated.

The String to Send section (top) allows you to add strings of commands to your tools. These strings can be used 
to control unique parameters for special tools. The four fields represent different times in the production sequence 
when i-cut will send the strings to the cutting device. Some common string commands are accessible from the 
buttons to the right of the fields. Adding strings is an advanced operation. If you have a need for additional tool
control beyond what is provided in the default setups, and would like technical assistance, please contact your 
i-cut dealer for support.

For Kongsberg Users:  i-cut communicates with XL/XE-Guide to determine exactly which tools have been installed
with your system. Because specific tool numbers differ from system to system, the standard configurations for 
i-XL/XE systems only load default parameters for one tool, the HS_Milling 0 tool (router), which is common to 
all MultiCUT equipped systems. Therefore, for all additional tools, Kongsberg users must activate the appropriate 
tool parameters and set the initial values for those parameters. To help you with this initial setup process, the 
following guidelines have been provided:

Through-Cutting Knives + Vibrating Knives
Parameter Value
Velocity Max
Acceleration Max
Depth X/Y 0/0
Tool-up Angle 45

Kiss-Cutting Knives
Parameter Value
Velocity Max
Acceleration Max
Depth X/Y 0/0
Tool-up Angle 60
Knife Pressure (XE only, both options) 30/0

Creasing Tools + Pens/Marking Tools
Parameter Value
Velocity Max
Acceleration Max
Depth X/Y 0/0

Editing Kongsberg Tools

i-cut provides direct access to your Kongsberg cutting table’s tool configuration via the 
Tool Setup button on the Kongsberg toolbar, or by selecting the same option in the 
Kongsberg menu. The Tool Configuration window allows you to identify tools and 
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adjust tool setup parameters such as height calibration, lag and offset. Click the More button to view some additional 
options.

In the More window you will find options to ignore automatic tool identification, 
manually add tools and delete tools. At some point you may need to delete a tool. 
To do so, select the tool from the drop-down box and click the Delete the tool button. 
You should delete the same tool from i-cut’s Edit Tools window. Deleting it from both 
locations will ensure that it does not re-appear next time you start your system.

Adjusting Kongsberg Tool Setup Parameters

To adjust tool setup parameters for individual Kongsberg tools, follow this basic 
procedure:

Insert the tool into an available toolhead position.

Click the Identify tools button in the Kongsberg Tool Configuration window. 
The tool should appear in the position corresponding to the toolhead position 
into which it is inserted. If this tool is being inserted into the system for the 
first time, a warning will appear stating that tool adjustments must be made.

Click the Adjust active tool button. Doing so will launch the Kongsberg Adjustment window.

Activate the Tool height calibration radio button and click Next. Follow the on screen instructions to complete 
the adjustment.

Repeat for Rotation adjustment, Center offset adjustment and Offset adjustment, ignoring any “Zero Lag” 
warnings.

Do not make any Lag or Manual adjustments. When you have completed all adjustments, click Finish to 
close the window. Repeat this procedure for each individual tool. You will need to adjust your Tool height 
calibration on a regular basis; anytime you change blades. The other parameters may require infrequent 
readjustments to maintain the best possible cut edge quality.

Calibrating the i-cut Vision Registration System
Before you can begin taking advantage of i-cut’s vision registration capabilities, you must calibrate the vision registration 
system to your cutting device. To ensure good cut to print registration, i-cut provides two camera calibration features.

Check Regmark

This feature provides visual and numerical feedback 
for registration mark recognizing. To access Check 
Regmark, go to the Calibration menu and select Check
Regmark. The Regmark Test window displays a video 
image from the i-cut camera, as well as dynamic values 
for variation and contrast. These values are provided 
to help you adjust the camera lens’ F-Stop and Focus 

1.

2.

3.

4.

5.

6.



24

rings, which are accessible through the two slots on the 
front of your i-cut camera. To perform the calibration, 
follow these steps:

Using the arrow keys on your computer keyboard, 
position the camera over a register mark (a 1/4” black 
filled circle on a white background is recommended 
for this initial calibration).

The center of the camera is represented by a small 
blue circle; position it directly over the register 
mark (you may need to make an initial adjustment 
to the camera’s F-Stop to see the register mark).

Adjust the F-Stop according to the Variation
and Contrast values. The best register mark read 
almost always occurs with minimum variation and 
maximum contrast. Try to set the variation as close to zero as possible and the contrast  as high as possible. 
Typical values reflecting a good read are: Variation 0, Contrast 10. To achieve this, the camera adjustments 
should be set to display a black register mark over a gray background (a reverse register mark should appear 
white over black).

Adjusting the Focus compensates for debris or reflection; by setting the 
camera slightly out of focus, you will dramatically improve your register 
mark read. i-cut displays a successful register mark read in the video image 
by generating a green box around the identified register mark, with a green 
crosshair defining the center point.

Camera Offset

The camera offset is the distance from the center of the tool to the center of 
the camera. Executing the camera offset measuring process ensures the best 
possible registration between your cutting device and i-cut. If your device is 
equipped with a multi-tool cutting head, i-cut gives you the ability to use any 
one of the tools to perform the camera offset. However, you 
only need to perform the camera offset once. You will need 
a piece of material, on which you will kiss-cut or through-
cut a small circle (register mark). Kiss-cutting black vinyl 
to expose the white liner provides plenty of contrast and 
works very well. To perform the camera offset, go to the 
Calibration menu and click Camera Offset. Then follow 
these steps:

Select Change in the Tool used for circle section of 
the Camera Offset window. This launches the Edit 
Layer window, used for selecting tools and setting tool 
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parameters. Select the tool you would like to use from the Tool drop-down 
list. Next make any desired changes to the tool’s default parameter values 
and prepare the tool in your cutting device. When you are finished, click 
OK to return to the Camera Offset window.

The Measure parameter in the Diameter of circle section defines the size 
of the register mark i-cut will cut and read to measure the camera offset. 
It is most often set to 1/4” (6 mm), but a slightly larger or smaller value 
is acceptable. The Check parameter defines the size of the circle used to 
check the camera offset, and it is usually set to 1/3”. This value can also vary, 
but should always be larger than the value of the Measure parameter.

To perform the camera offset, click Measure in the Offset section. Then 
move the selected tool over an unused portion of the material using the 
mouse or arrow keys on your computer keyboard. When you select OK, i-
cut will cut the register mark. Carefully remove the waste material without 
changing the position of the material on the cutting surface. Now position 
the crosshair in the Regmark window over the register mark and click OK.
i-cut will read the mark and update the X-axis and Y-axis offset values to 
reflect the new camera offset.

To verify the accuracy of the new camera offset, select Check in the 
Offset section. Then, re-position the target in the Regmark window over 
the register mark and click OK. i-cut will cut a larger circle around the 
register mark. If the camera offset is accurate, the distance from the edge 
of the register mark to the edge of the check circle should be equidistant on all sides. If the check produces 
inconsistent results, repeat the procedure; modifying the camera’s F-Stop and Focus, if necessary.

The camera offset is now complete and i-cut is configured and ready to drive cutting device. To maintain 
accurate registration over time, it is recommended that you re-calibrate the vision registration system often. 
Re-calibration is critical if you exchange your plotter’s cutting head or remove and re-attach the camera for 
any reason.

Feeder Connection

MGE i-SF sheet feeders, and upgraded (with touch screen) MGE 2nd Generation sheet feeders may be controlled 
automatically from i-cut. To establish communication between i-cut and your sheet 
feeder, follow these instructions:

Connect the feeder to your computer via an available serial COM port, or USB-to-
serial adapter.

From your Windows Device Manager, locate the COM port settings of the port to 
which the sheet feeder is connected.

Change the settings to match these values:  COM Port Number: 3 - Bits per second: 
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9600 - Data bits: 8 - Parity: Odd - StopBits: 1 - Flow control: None.

From i-cut, select Feeder Connection from the Configuration window.

Adjust the parameters in the Feeder window to match the corresponding values your Device Manager.

Enable i-cut communication on your sheet feeder’s touch screen.

Open your i-cut Configuration window and verify that the MGE Feeder option is presently available on your dongle. 
If it is not, contact your i-cut dealer to request a control word.

Backup and Restore

After your system has been fully configured, you should back it up using the Backup 
and Restore system. Performing a backup will save all of i-cut’s essential parameters, 
including: Production Options, Tools, Menus, Calibration Settings, etc... If your 
system stops performing properly, you can easily restore all settings to this original 
snapshot of your system.

To perform the backup, select Backup from the File menu, name the file and click 
Save. Backup files are automatically saved to a backup directory (C:\Program Files\MGE\i-

cut\Backup). It is recommended that you save this first backup to a safe location on your 
network as well.

To restore a backup, select Restore from the File menu and select the file you would like to restore, then click Open.

Shutting Down your System

To properly shut down your i-cut system, first make sure there that no jobs are currently running. Then simply close 
i-cut by clicking the Close button in the upper right corner of the window, or by selecting the Exit option from the File 
menu. Turn off your cutting device by following the manufacturer provided instructions. Kongsberg users should turn 
the cutting table Servo motors off before switching off the table’s power switch.

Software Upgrades

After you’ve installed i-cut, you will be automatically notified when future upgrades become available. If your i-cut
computer has access to the internet, i-cut will automatically connect to the MGE website and notify you of any available 
upgrades.
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Preparing and Managing Files

Preparing Files for Import

i-cut imports these four file types: .ai, .pdf, .dxf and .hpgl. Currently most users prepare files for import with Adobe 
Illustrator, however any vector-based design or drawing software capable of outputting one or more of the compatible 
file types may be used. We offer a special plug-in for Illustrator users called ai-cut, which contains several tools for 
automatically and manually inserting registration marks into your jobs.

Defining Cut Paths

Every job imported into i-cut requires cut paths, which are vector curves made of line segments, arcs Bezier 
points, etc. These paths are normally created or defined in your design software. The cut quality of your finished 
jobs is the direct result of the quality of the cut paths you create. i-cut has some basic tools for optimizing cut 
path quality and improving processing speed, but poorly drawn paths will produce poor cutting results. The best 
cut paths are smooth curves that wrap perfectly around the simplest and most intricate details. Poor cut paths 
consist of curves that wander in and out of registration, or rough curves made from an excessive number of points. 
Vectorization of raster graphics often generates poor curves that must be refined manually before cutting.

To ensure proper registration between printed graphic and cut, each cut path and register mark must be perfectly 
aligned to the associated graphic and register mark in the print file. Normally the cut and print data are created at 
the same time and separated into two files before the job is produced. This file separation can be done manually 
before printing, or if the job is going to be digitally printed the i-script workflow enables compatible RIP softwares 
to automatically separate the files before outputting to the printing device.

Adding Registration Marks

All jobs destined for processing on your i-cut vision registration system should contain registration marks. By 
adding regmarks to both the print and cut files, you are providing i-cut with the necessary information to register 
the cut path to the printed graphic. The placement and total number of regmarks depends on the required cutting 
tolerance, and the predicted amount of distortion. Using ai-cut greatly simplifies the process of adding regmarks, 
but you should still understand the basic concepts explained in this section.

i-cut allows users to select one of five different types of registration. These registration types dictate how i-cut 
will register and modify cut paths based on the information it collects from reading regmarks. Here are the five 
registration types:

Placement:  This simplest form of  registration rotates and positions all curves in all layers as one group. Size, 
shape and relative positioning of the curves all remain intact.

Register Curve:  Each curve is produced at the exact size and shape defined by the file, but registered 
individually from all other curves in the file; compensating for positional and rotational changes in the printed 
job.

Register Layer:  Similar to Register Curve, this registration type produces each layer individually. All curves 
in each layer will maintain exact size, shape and relative positioning.
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Linear Compensation:  This registration type offers the second highest level of compensation. When Linear 
Compensation is selected, i-cut applies an average compensation factor, based on the collected information. 
The size, shape, offset and rotation of all curves are altered to compensate for linear distortion in the printed 
graphic or material. Linear Compensation is rarely used because Full Compensation provides superior 
registration and compensation, but it is still included as an option.

Full Compensation:  When selected, i-cut adjusts each individual point on every curve according the 
positions of the three register marks closest to those points. This process includes (but is not limited to) offset, 
scale, rotation and skew of all curves. Full Compensation offers the highest level of compensation available 
and provides the closest possible match of cut path to printed graphic.

Understanding the registration capabilities of i-cut will help you decide how 
many marks to add to your job, and where to place those marks. Jobs printed 
with large amounts of bleed or jobs that must maintain an exact overall size, 
or contain cuts that must maintain an exact relative size may be produced 
using Placement, Register Curve, Register Layer. Just a few marks around the 
outer edge of each path or group of paths provide sufficient information for 
these registration types. Jobs that require precise cut to print registration, or 
precise outer border width should be produced with Full Compensation.

Unstable materials such as flexible or applied graphics also most often require 
Full Compensation for proper registration. Jobs produced with traditional 
printing methods, like screen printing, contain the greatest amount of 
distortion. Digitally printed jobs generally contain less distortion, but 
accuracy varies greatly from printer to printer. Producing digitally printed 
jobs with tight tolerances still requires some compensation.

For the best possible compensation, registration marks should be placed 
around, and inside (if possible) the cut path in a triangular relationship to 
one another. Jobs with tighter cutting tolerances require more register marks. 
The more marks, the smaller each triangulated area becomes, and the more 
accurately i-cut will be able to compensate for distortion in that area. If 
there are specific areas within the job that are more critical than others, more 
regmarks should be added to those areas. It’s difficult to accurately predict the 
amount of distortion that will occur in any printed job, therefore we suggest 
you always include more regmarks than you think you will need. You can 
always remove unnecessary regmarks later in i-cut, but once the job is printed 
it is impossible to add more regmarks.

Jobs longer than your cutting table will be divided and produced by i-cut in 
sections. Adding regmarks along these divisions will improve registration and 
alignment of cut paths between sections.

Types of Registration Marks

i-cut supports two types of registration marks, filled and reversed.

•
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The first regmark type, a filled circle approximately 1/4” (6 mm) in diameter, is the best choice for nearly all 
scenarios. If there is a high amount of reflection, or insufficient contrast between the color of the printed register 
mark and the background, a reversed 1/4” (6mm) circle may provide i-cut with a better regmark reading result.

Color Registration

i-cut also compensates for imperfect color registration in screen printed graphics. By printing register marks in 
the color to which you  want to register your cut lines, you can ensure accurate registration to that color. You can 
even register to more than one color in the same job by registering and cutting objects individually.

Defining Layers

i-cut separates data into layers, and will recognize layers and layer names in the files you import. By defining 
layers in your design software, and using layer names to define intended finishing methods, you simplify the setup 
process in i-cut. Using a standard layer naming scheme will make it easier to work with templates and reduce job 
setup time. When importing an .hpgl file, i-cut allows you to separate the contents into four layers based on pen 
number (1-4). Here is a list of the layer names most commonly employed by i-cut users:

Regmark

Kiss Cut

Through Cut

Pen Plot

Crease

Score

Router Cut

Laser Cut

Simplifying Content

Removing unnecessary data from your files will improve compatibility and reduce file size. i-cut only utilizes 
vector cut paths and register marks. All other data, such as raster images, raw text, effects, splines, etc... should be 
removed from the file before saving or exporting.

Saving Files

When saving your files for direct import into i-cut, remember to use one of the supported file formats. Adobe 
Illustrator users should save as .ai or .pdf. if saving as .pdf, be sure to preserve illustrator editing capabilities. Auto 
CAD users should save as .dxf.

Preparing Files for the i-script Workflow

The i-script workflow provides the best solution for cutting jobs that have been digitally printed through RIP softwares. 
By including cut data in your print files, and configuring the RIP to generate i-script cut files, you can easily process jobs 
that have been nested or tiled by your RIP. Each time a job is printed a new cut file is generated. This guarantees an exact 
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match between the cut file and the printed job. In addition, RIPs can automatically generate bounding box cut lines and 
register marks around bounding boxes. Some RIPs have even implemented barcoding for automated production and 
file retrieval in i-cut. i-script support has been implemented by several of the top RIP companies, but the capabilities of 
different RIPs vary from one to another. Look for your RIP on the chart below, and read your RIP software’s user manual 
for the most recent information on its capabilities.

Defining Cut Paths

Cut paths intended for the i-script workflow are defined in the same manner as they are for import. However 
not all RIPs support open cut paths. Depending on which RIP you are using, you may be limited to closed cut 
paths.
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Assigning Spot Colors

Most RIPs use spot colors to identify cut paths and register marks. A spot color with a specific name or prefix is 
assigned to the fill or stroke of the cut path. The RIP recognizes the spot color name and separates the cut data. 
In order for the RIP is able to recognize existing register marks, a special spot color name may be required. Refer 
to your RIPs software manual to learn about its specific requirements. The following instructions are specific to 
Adobe Illustrator, but most design programs provide a similar solution.

To assign a spot color to the cut path:

Select your cut path(s) and, depending on which RIP you are using, apply a fill or 
stroke.

Open the Swatches palette from the Window menu and click the New Swatch icon 
on the toolbar.

Double-Click the new swatch to open the Swatch Options window.

Enter the supported spot color name in the Swatch Name 
field.

Change the Color Type to Spot Color. The actual color is 
not important, only that it is a spot color.

Click OK to exit the Swatch Options window.

Saving Files

To maximize compatibility, we recommend that you use the .eps file format with Postscript Language 
level 3 enabled, or the .pdf format with Illustrator editing capabilities preserved. If you prefer another 
format, verify compatibility with your RIP software.

Using ai-cut

ai-cut adds the i-cut Register Mark tool to the Illustrator toolbar, which works in exactly the same manner 
as any other toolbar button. Left-click and hold expands the button, while clicking the arrow to the right of 
the expanded button creates a floating palette. Double-clicking the button opens the i-cut Register Marks 
window, which contains options related to the tool.

Illustrator’s Filter menu provides access to the remaining ai-cut tools. By expanding the MGE i-cut
Preparation submenu, you can access these features:  Add i-cut Layer, Add i-cut Register Marks (same 
window as accessed by double-clicking the toolbar button) and Preflight for i-cut.
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Inserting Registration Marks

To quickly insert marks manually, select the i-cut Register Mark tool from the toolbar. Your mouse pointer will 
change appearance to reflect your tool selection. Note:  Turning on Illustrator’s Use Precise Cursors option will 
produce a crosshair pointer instead of a representation of the selected Regmark tool. Clicking anywhere in your 
work area will produce an i-cut regmark, which is automatically placed into a newly generated Regmark layer. 
Select the Filled or Reversed mark from the toolbar tool and notice the difference when inserting the marks. Once 
marks are inserted, they may be moved, deleted or modified just like any other curve in Illustrator.

Setting Regmark Appearance and Action Parameters

To set regmark appearance parameters, open the i-cut Register Marks window by 
either double-clicking the toolbar button, or by selecting Add i-cut Register Marks
from the Filter menu. The Appearance section at the top of the window provides 
these parameters, which dictate regmark appearance:

Type:  The selection of type coincides with the two types of marks available 
from the toolbar. Notice when you select one type or another and exit the 
window, the toolbar button changes accordingly. Filled marks are used in 
most cases and provide the best contrast on nearly all materials. Reversed marks are often used when printing
on reflective surfaces, to help provide additional contrast by using the printed ink to mask the material on 
which it is printed.

Diameter & Outer Diameter:  These two parameters control the size of the regmarks. Outer diameter is only 
available when using the Reversed mark type.

Colors:  Clicking the Use Current button will change the color of the regmarks to the currently selected color, 
which is displayed in the Fill box on the toolbar. In order to be used, this color must be a CMYK or RGB 
color and cannot be a gradient, spot color or other type of fill. If you would like to use one of these other fill 
types, such as a spot color, apply it to the marks after you have inserted them.

The Action section of the window defines the action that will be taken when exiting the i-cut Register Marks 
window. These three choices are provided:

Add Marks Manually:  Selecting this option will apply all changes made to appearance 
parameters to the i-cut Register Mark manual insertion tool.

Add Corner Marks:  If this option is selected, ai-cut will generate a single set of corner 
marks around the entire visible contents of the file. It will automatically generate two 
marks in one of the corners to help avoid confusion when cutting nearly symmetrical 
layouts.

Add Auto Marks:  Add Auto Marks intelligently places multiple register marks within
the limits of the Illustrator Artboard (defined in the document setup). Exact positions 
of the marks are determined relative to the visible contents of the file. The number of 
marks is set using the Quantity slider, which becomes available as soon as the option is 
selected. The exact number of marks depends on the size of the Artboard and the visible 
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contents of the file. Moving the slider to the left decreases the number of marks, while 
moving it to the right increases the number.

Application

As mentioned above, regmarks are inserted based in the visible contents of the file. That 
means that it if there are objects in the file which you do not want ai-cut to consider 
when placing marks, you should remove them from the file or hide them using the Layers 
palette.

Marks may be inserted into any open space in the Artboard, meaning paths that are only
stroked (not filled) contain open space, and ai-cut may place marks inside this space. If you 
show the Grid from the View menu (making sure the Grids In Back preference is checked), 
any space within the Artboard where the grid is visible is a space into which a regmark may 
be placed.

Add Auto Marks should only be used when Illustrator’s Preview mode is active. If Illustrator 
is set to Outline mode, regmarks may be placed inside objects. Illustrator displays no filled 
spaces when this mode is active.

Regmarks are automatically placed in a new layer named Regmark. As long as they remain 
in that layer each time you run Add Auto Marks, ai-cut will remove any regmarks in the 
layer and replace them with new marks reflecting your quantity selection. If you would like 
to change the quantity, you are not required to manually remove the regmarks.

Raster images and clipping paths are enclosed by a bounding box. Although these types of 
objects may appear to contain transparent space, they are treated as filled spaces by ai-cut.
Therefore, it is a good idea to insert regmarks according to your vector cut paths, and not 
your final print objects. To do this simply hide the layers containing your print data before 
executing Add Auto Marks.

Additional Tools

Add i-cut Layer

To generate a pre-defined i-cut layer, open the i-cut Layer window by selecting Add 
i-cut Layer in the Filter menu. The window contains an i-cut Layer drop-down menu 
containing the list of available layer name selections. 
Selecting any one of these choices and clicking OK will 
result in ai-cut adding a new blank layer to your Layers 
palette named according to your selection. Placing your 
artwork, intended for finishing on an i-cut system, into 
layers with these pre-defined names will allow your i-cut
users to take full advantage of the i-cut template system, 
which greatly reduces job setup time.
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Preflight for i-cut

Selecting Preflight for i-cut from the Filter menu 
commands ai-cut to perform a preflight check on the
contents of your file. This check verifies that all layer 
names match those in the pre-defined list. If there are 
any mismatches, a warning is displayed. Running the 
preflight check with all layers are named correctly will
result in a message stating that the file is ready for i-cut. The 
preflight check should be performed just before saving your files
for i-cut.

Managing Files

The File menu contains several familiar options for managing files. It also 
displays your last six files, provides access to the Production Manager, Print 
options, Backup and Restore, and allows you to exit i-cut. Several file menu 
options are also accessible from the Toolbar. These familiar options are 
provided:

New:  Creates a new (blank) job file.

Open:  Selects and opens i-cut job files (.Cut), template files (.prm) 
and Kongsberg setup files (.mat).

Save:  Names and saves your file as a job or template.

Save As:  Saves your previously saved Job file with a different name, or as a template.

Merge:  Combines the file currently open with a previously saved job, template or 
Kongsberg setup file.

Import;  Imports compatible .ai, .dxf and .hpgl files into i-cut. To apply a template while 
importing, simply open the template prior to importing your file.

•
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Setting Up Jobs for Production

Before producing any job, you must set your file up for production. i-cut’s simple user interface provides all the options
necessary for setting up the simplest to most complex jobs your plotter is capable of producing. Setting up jobs is a fast 
process, normally taking only a few minutes. If you repeatedly run the same types of 
jobs, using templates will greatly reduce your setup time.

To view some example job and template files, look in the \\MGE\i-cut\Sample Files and
\\MGE\i-cut\Templates folders.

Layers

i-cut organizes all cut and registration data into layers, while assigning a unique set 
of options to each layer. Layers define tools, tool parameters and registration types. 
When you run a job, i-cut will produce that job based on the order, selection and 
configuration of your layers. All layers are located in the Layers palette, on the left 
side of the main window. The layers are presented as buttons, and display the current 
state of the layer.

Managing Layers

All layer management is conducted using the options provided in the Edit 
menu. Many of these options can also be accessed using the Layers toolbar, 
located at the top of the Layers palette.

Edit Layer:  Provides access to the Edit Layer window 
for the selected layer(s). Several tool-related parameters 
are all edited from the Edit Layer window. Common 
parameters include: Velocity, Acceleration, Pen Select, 
Knife Pressure, Spindle RPM, Laser Power, etc. Available 
options depend on the device and tool selected. You 
may also define the color in which the layer’s cut data 
will appear in the main window by clicking the Color 
Palette button to launch the Color palette.

Add Layer:  Creates a new (empty) layer and launches 
the Edit Layer window, for that layer.

Add Regmark Layer:  Allows you to create a new layer containing up to 
four registration marks. The quantity, positioning and size of the regmarks 
is defined in the Add Regmark Layer window, which is automatically 
launched when you create the layer.

Copy Layer(s):  Generates an empty copy of your selected layer(s), which 
retains all of the layer parameters.
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Copy Layer(s) with Curves:  Makes an exact copy of your selected layer(s), including all curves and layer 
parameters.

Remove Layer(s):  Deletes any selected layer(s). If curves are present, i-cut will display a warning before 
deleting.

Select all Layers:  Selects all layers.

Deselect all Layers:  Deselects all layers.

Remove Unused Layers:  Deletes all layers that do not contain curves.

Understanding the Layers Palette

Selected layers appear darkened and depressed. When selected, all vector data 
contained in the layer appears in the main window. Multiple layers are selected 
by clicking on them while holding CTRL or Shift, or with the Select all Layers 
feature. The layer name is displayed in the center of the layer. To change the 
layer name, or edit any of the layers parameters, use the Edit Layer window. To 
do so directly from the Layers palette, simply double-click the layer.

The box on the left side of the layer displays the color of the layer’s vector data 
as it appears in the main window. It also indicates the content of the layer. 
A filled box signifies content, while an outlined box indicates that the layer 
contains no curves. As white is an available color in the palette, a box that appears to contain no fill or outline 
may actually contain curves. To make the curves visible, change the color assigned to the layer. The Color palette 
can be accessed directly from the Layers Palette by double-clicking the color box.

Important tool information is displayed on the right side of the layer. Tool indicates that no tool has been assigned 
to the layer, and i-cut will not produce any layer without a tool. Once a tool has been selected, Tool will no 
longer appear on the layer. A white circle with a black crosshair in the center indicates an i-cut camera layer. Tool 
selection changes are made in the Edit Layer window.

The buttons across the top of the Layers palette provide easy access to many of the functions in the Edit menu. 
Right-clicking on any layer, or on an empty area in the Layers palette also provides access to several of the edit 
features.

Working with Curves

All drawing and editing of curves is normally completed before importing your file. Although i-cut is not a design 
program, it does provide some basic tools for making minor corrections to imported curves. i-cut also provides tools for 
preparing curves for specific types of production, and for improving the cutting performance of curves.

Working with curves includes editing and applying preparation tools to individual curves or groups of curves (Editing 
Curves), as well as editing curve points and modifying curve and point parameters (Editing Points). It is even possible to 
generate several types of simple curves.
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Viewing and Selecting Curves

i-cut makes selecting and viewing curves a comfortable and efficient process. The set of familiar zoom tools 
available from the View menu, Edit menu and Toolbar need little explanation. Selecting curves is as easy as 
clicking on individual curves or dragging a marquee around groups of curves. You can also view important curve 
information, such as curve point location, cutting direction and start point location.

Fit to Data:  Fit to data is located in the Edit menu, as well as on the Toolbar. This function fits the main 
window to display the full content of the job at maximum size.

Zoom In/Out/Window:  The zoom tools enlarge or reduce the size of curves on screen. To use Zoom In and  
Zoom Out, select them from the View menu, or click on their respective icons on the Toolbar. Selecting the 
Zoom Window feature from the same locations allows you to draw a marquee around the area you wish to 
enlarge.

Edit Job:  The Edit Job window is opened from the Edit menu. It allows precise control over the viewing 
position of the job in the main window. The size and offset values control the overall scale of the window, as 
well as the job’s distance from the lower left corner. Fit to data is also accessible from the Edit Job window.

Curve Direction:  Curve Direction is located in the View menu and on the Toolbar. Turning on this option 
displays the start point location and curve direction of all curves in the main window.

Curve Points:  This option is also found in the View menu and on the Toolbar. Turning it on displays all 
points on all curves in the main window.

To select individual curves, left-click on or inside them. Multiple curves are selected by holding CTRL while 

making the selection, or by left-clicking and dragging a marquee around the curves you wish to select. The 
marquee must completely enclose the curves intended for selection. To easily select all curves, hold ALT and click 
anywhere in the main window. To deselect all curves, click any empty area. Deselect a single curve by holding 
CTRL and clicking on or inside it. To select or deselect an outer curve with all its inside curves, hold down Shift 
while selecting it.

Transferring curves from one layer to another is done by dragging the selected curves onto the intended layer in
the Layers palette. For a layer’s curves to appear in the main window, that layer must be selected. Selecting all 
curves in a single layer is accomplished by selecting that layer and ALT-clicking anywhere in the main window.
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Editing Curves

Once you’ve selected the curve(s) you intend to edit, the curve editing tools 
in the Edit menu become available. When you select the tool you wish to use, 
you will either be presented with its options, or see the results immediately in 
the main window.

Invert Curve Direction:  Inverts the cutting direction of the selected 
curve(s). The results are visible only when Curve Direction is enabled.

Remove Curves:  Deletes the selected curve(s).

Mirror:  Mirrors/flips the selected curve(s) according to the options in the 
Mirror window. Curves may be mirrored vertically or horizontally.

Rotate:  The Rotate window appears when Rotate is selected from the Edit
menu. It allows you to choose the angle and direction of rotation.

Move:  Moves the selected curve(s) the X/Y distance specified in the Move 
window.

Optimizing Curves

Optimizing improves the cutting performance of curves by re-drawing them to
a specified tolerance as lines and arcs. Curves are automatically optimized when producing, but i-cut’s Optimize 
Curves feature is available for optimization of curves before production occurs. It also offers additional options, 
and is available from the Preparation menu, as well the Toolbar. Several options for optimizing are located in the 
Optimize Curves window, including: Tolerance, Break Long Lines (by Length), Make Sharp/Rounded Corners 
(by Radius) and the choice to Replace existing Curves or Generate a new Layer containing the opmized curves.
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Tool Compensation (Offset)

Tool compensation is most often used when preparing files 
for routing/milling, or for laser cutting. It allows production 
of finished cut pieces to their exact drawn dimensions by 
compensating for bit/beam diameter (CED). To use tool 
compensation, make a selection of all curves you intend to 
cut and select Tool Offset from the Preparation menu. i-cut’s 
automated tool offset, controlled from the Edit Layer window, is preferred to the Tool Compensation feature in 
most cases because it automates the process and provides several more features specifically for routing/milling. 
Automated Tool Offset is explained in detail later in this part of the manual.

Layer:  Displays the name of the layer onto which compensated curves will be generated. Use the default 
name (Tool Compensation), select the name of an existing layer from the drop-down list or enter a name to 
generate a new layer. To avoid confusion, it is best to create or select a layer that does not contain any of the 
original curves.

Left:  Checking this box instructs i-cut to generate the compensated curves to the left of the cutting direction 
of the original curves; leaving it unchecked will generate the curves to the right. Unchecked (right) is the 
default, and usually the correct choice because it works properly with the default Curve Direction settings in 
the System Options window’s Import Options section. The Invert direction for inside curves import option 
is especially important because it allows you to apply tool compensation to groups of nested curves once, 
without having to make changes to the Left setting.

Size:  Defines the offset distance from the original curve to the compensated curve, which is normally 1/2 the 
bit/beam diameter.

Lead-in/Lead-out

The Lead-in/Lead-out feature is also primarily used for routing/milling and laser cutting. It should always be 
applied after tool compensation (if used). Adding Lead-in/Lead-out to a curve opens and extends the curve so 
that cutting begins and ends outside the path. This is important for routing/milling because the bit’s initial plunge 
into, and removal from, the material can produce cutting results which are inconsistent with the rest of the cut. 
For laser cutting, the beam produces a wider cutting channel at the start and end points. Applying this feature 
ensures consistent cutting around the entire edge of the part. To use it, make a selection of your intended curves 
and click Lead-In/Lead-Out in the Preparation menu.

Lead-in/Lead-out:  Usually Lead-in and Lead-out are used in conjunction 
with one another, but you may choose to use only one or the other.

Left/Right:  Select whether the Lead-in and/or Lead-out will appear on 
the left or right side of the curves’ cutting direction.

Radius:  The Lead-in and Lead-out are always generated as absolute arcs, 
with the Radius defining the size. The Radius should be large enough to 
ensure the bit diameter is away from the part, or the beam has adequate 
distance to accelerate/decelerate.
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Editing Points

i-cut’s Edit Points mode is enabled from the Edit menu, as well as from the Toolbar. Curves are edited individually 
using right-click functions. Simple curves are also generated with Edit Points mode enabled.

To edit points on an existing curve, select the curve in the main window with Edit Points mode enabled. Notice 
that the curve points are automatically displayed. Now, right-click on the point you wish to edit. A menu will 
appear listing several options for editing the chosen point. Fewer options are presented for point types other than 
corner. To move individual points using the mouse, right-click on the point you wish to move and drag it. Any 
changes made using Edit Points mode can be reversed using i-cut’s Undo feature.

Edit Point:  Launches the Point window, from which you edit the X/Y 
coordinates and Type of the point. Different types of points are displayed 
as different colors in the main window; corners are displayed as blue, arcs 
as red and Beziers as green.

Remove Point:  Removes the point from the curve. You may remove 
multiple points on a curve at one time by right-clicking and dragging a 
marquee around the points you wish to remove.

Smooth:  Re-positions arcs or Bezier points to produce a smooth cutting 
path between the points before and after.

Add Regmark:  Generates a register mark based on the information in the 
Add Regmark window. The Position, Size and Layer are all editable. If no 
layer is selected, the new register mark will be placed in the Regmark layer. 
If a Regmark layer does not exist, it will automatically be created.

Use as Start point:  Defines the chosen point as the start point for cutting; 
only a corner can be used as a start point. If the curve is open, the start 
point is determined by the curve direction.

Add Lead-in/Lead-out:  Allows you to add a Lead-in and/or Lead-out 
to a chosen corner point. Selecting this option launches the same Lead-in/Lead-
out window available from the Preparation menu. Using Add Lead-in/Lead-out 
automatically re-locates the start point to the appropriate position.

Right-clicking on an empty section of a curve (not containing a point) will result in a 
menu displaying the following options:

Add Corner/Arc/Bezier:  Adds a point of the corresponding type to the specified 
area.

Open/Close Curve:  Opens the curve in the chosen area, if the curve is closed. If the curve is open, this option 
closes it. This action generates a line straight from the start point to the former end point.

Add Regmark:  This option works in exactly the same manner as described above.
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Generating Curves

To generate a new curve, right-click and drag a marquee around the area of 
the main window where you would like the curve to appear. The size of the 
marquee will determine the size of the curve. Then select the type of curve you 
want to generate from the menu that appears next to the marquee. If another 
curve is selected when you draw the marquee, the new curve will appear in the 
same layer as the selected curve. If no curve is selected, the new curve will appear 
in a new layer named Shape.

Automated Tool Offset and Advanced Routing/Milling Features

The Edit layer window provides access to automated tool offset and 
advanced routing/milling parameters. These parameters increase 
functionality and greatly simplify job setup for routing/milling. 
Automated Tool Offset and Advanced Routing/Milling are meant 
to be used with closed curves. If you’re job requires producing 
open curves, results will depend on those curves’ normal cutting 
directions. To change cutting directions, use the Invert Curve 
Direction feature in the Edit menu.

Tool Offset:  Two drop-down boxes allow selection of Outside/
Inside and Clockwise/Counter Clockwise routing. Selecting 
Outside or Inside will cause i-cut to produce curves in the layer 
with an outside or inside offset. Inner nested curves will alternate automatically so that the offset always occurs on 
the side of the waste. Selecting Clockwise/Counter Clockwise determines the cutting direction for all curves in the 
layer and overrides the curve’s normal cutting direction.

Tool Diameter:  Input the diameter of your router bit in this field. This diameter determines the tool offset when 
the job is produced.

Multi Pass Depth:  Multi-pass cutting is the process of cutting the same paths multiple times at increasing depths. 
This parameter represents the cutting depth (Z) of each pass, and is dependent on Material Thickness. The total 
number of passes is defined by the Material Thickness divided by the Multi Pass Depth. For example, cutting a 
material that is 5mm thick with a Multi Pass Depth of 2mm would require 3 passes: the first pass would make a cut 
2mm into the top of the material, the second pass would be 4mm deep, and the third pass would cut the remaining 
1mm. Inputting a value of 0 will produce your job with a single pass.

Material Thickness:  Input the thickness of your material in this field.

Finishing Pass Offset:  A finishing pass is the last pass of a multi-pass production. This pass is slightly offset, or 
contracted, from the other passes. The result is a final pass that shaves the entire edge of the part; removing any 
evidence of the multi-pass production, and producing a smoother edge. i-cut will automatically increase the Tool 
Offset to compensate for the Finishing Pass and produce the curves at the intended size.

Web Thickness:  When producing a job with a Finishing Pass Offset, inputting a Web Thickness offsets the depths 
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of all passes so that only a thin amount of material is left for the final pass. The vacuum hold-down strength of all 
cutting systems have limitations, and small parts can shift on the cutting surface when they are routed. The result is 
an undesired cut on the edge of the part where the router bit made contact during the shift. This result is eliminated 
or greatly reduced using Web Thickness. When the router bit has less material to cut on the final pass, there is less 
chance of the part moving when the cut is completed.

Drill Holes:  Activating this checkbox with cause i-cut to drill a single hole, which is the exact diameter of your bit, 
in the center of every curve on the layer. The actual curves themselves will not be produced, only the drill holes. It 
is therefore required that you place drill hole objects on a layer separate from any other contours you would like to 
produce.

Tool Path Preview

Using Tool Path Preview, the tool path generated
by the automated tool offset is displayed in the 
main window. The tool diameter is displayed by 
a thick line, which is displayed as the half-tone 
of the layer color. To turn Tool Path Preview on, 
click the Tool Diameter button on the toolbar. 
This feature is very useful for determining how 
a bit will cut inside corners. Use the zoom tools 
to check critical areas or important details before you run your job. You should only enable this function if 
needed, as it can slow down the performance of the user interface.

•
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Producing Jobs
After setup is complete, your job is ready for production. All job production is performed via the Production Manager. 
i-cut provides two options for the appearance of the Production Manager: Advanced, for setting up all production 
variables and Basic, for repeating production. The Production Manager is can be launched from the Toolbar, or from the 
File menu.

Normal Production

i-cut provides three modes of production: Normal, Barcode and Edge Recognition. Normal production is active when
the Normal tab, at the bottom of the Production Manager, is selected. Several of the variables available in Normal mode 
are also used when producing jobs with Barcode and Edge Recognition.

Sheet Mode

Two Sheet Modes are available from the Sheet Mode section of the Production Manager: Normal mode and Smart 
Feed. To use Normal mode, leave Smart Feed unchecked.

Normal Mode:  This is the standard mode for producing jobs with i-cut. When used with vision registration, 
it allows i-cut to learn the positions of multiple copies on a sheet, and/or multiple sheets on the table. i-
cut is manually shown the positions of the first few copies in the first layout, and then it will  attempt to 
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automatically find the remaining copies on the table. For every remaining table, the software will remember 
all positions for all copies.

Smart Feed:  Most often used when producing roll fed jobs. Using this sheet mode allows i-cut to smart feed 
material between copies; saving time by moving the cutting device’s beam back only the necessary distance 
to pull the next copy to position. In addition, Smart Feed allows i-cut to intelligently choose where to divide 
jobs longer than the table; making automated roll feeding of long jobs extremely simple. Smart Feed is only 
available when using register marks.

Registration Type

Registration Type dictates how i-cut uses the information collected with the vision registration system to process 
the job. The five available registration choices solve almost every imaginable registration issue. Additionally, i-cut 
allows multiple registration types in a single job via the Registration Type parameter in the Edit Layer window. 
Assigning a registration type to a specific layer automatically overrides the Registration Type selection in the 
Production Manager.

Placement:  This simplest form of  registration rotates and positions all curves in all layers as one group. Size, 
shape and relative positioning of the curves all remain intact.

Register Curve:  Each curve is produced at the exact size and shape defined by the file, but registered 
individually from all other curves in the file; compensating for positional and rotational changes in the job.

Register Layer:  Similar to Register Curve, this registration type produces each layer individually. All curves 
in each layer will maintain exact size, shape and relative positioning.

Linear Compensation:  This registration type offers the second highest level of compensation. When Linear 
Compensation is selected, i-cut applies an average compensation factor, based on the collected information. 
The size, shape, offset and rotation of all curves are altered to compensate for linear distortion in the printed 
graphic or material. Linear Compensation is rarely used because Full Compensation provides superior 
registration and compensation, but it is still included as an option.

Full Compensation:  When selected, i-cut adjusts each individual point on every curve according the 
positions of the three register marks closest to those points. This process includes (but is not limited to) offset, 
scale, rotation and skew of all curves. Full Compensation offers the highest level of compensation available 
and provides the closest possible match of cut path to printed graphic.

Option Set

All Production Options appear in the Option Set drop-down menu. Select the Production Option that best suits 
the type of production required by your job. All editing of Production Options is conducted in the Production 
Options window, which is available from the Options menu.

Copies

This section provides fields for inputting the total number of copies, as well as the number of steps you would 
like to produce.
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Steps:  Entering a number of steps in X and/or Y allows you to place multiple copies on the cutting surface,  
and process them with a single production. The second step parameter for X and Y represents the position 
of the steps (copies) relative to one another. This parameter can be set to Step Size (total size of the step), 
or Distance (distance between copies). If the value is set incorrectly, i-cut will still produce the job correctly 
by remembering the position of every copy on the table for each additional table processed during the 
production.

Total number of Copies:  Enter the total number of copies you would like to produce. If Calculate is  checked, 
the total number of copies for a single table is calculated based on the number of Steps in X and Y.

Layers

The Layers section displays all the layers in the Layers palette. It allows you to select and deselect layers without 
closing the Production Manager. All layer editing must still be done from the Layers palette.

Size

This section provides proportional scaling for your job. Enter a scaling percentage or a dimension in X or Y. If 
a value is entered in one dimension, the other dimension will update automatically with the proportional value. 
Information collected by the vision registration system will always take precedence over the manually entered size. 
If you know your job with regmarks is scaled by a certain percentage, or to a certain size, you may enter a size 
anyway to reduce the time needed to locate the regmarks on the first copy of your production.

Placement

The Offset value in the Placement section defines the distance (on the cutting surface) between the job and the 
cutting device’s 0,0 point, or variable reference point. Checking Update allows i-cut to re-write the offset values 
based on the positions of the printed registration marks. Update is only used when producing jobs with regmarks. 
When Use Work Area is checked, i-cut produces the job on the plotter bed as it is positioned in the main window. 
Use Work Area has no function when producing jobs with regmarks.

Park Position

If the selected Option Set commands the plotter to park before, between or after producing tables, the cutting 
head will move to the position entered in the Park Position section. The position is relative to the cutting device’s  
0,0 point, or variable reference point.

Sheet Feeder

Feed Length sets the distance the cutting device will feed the sheet(s) when using a sheet feeder. The Option Set 
must support sheet feeding in order to use the Sheet Feeder section. Setting the value properly ensures minimum 
feed time. The Feed Length is usually approximately equivalent to the sheet length or slightly larger. If multiple 
sheets are on the table at one time, the length may be set slightly smaller, which maximizes vacuum by creating 
an overlap. Loading multiple sheets on the table is accomplished by entering a quantity in the Pre Load field. 
When a quantity is entered, the cutting device will communicate with the sheet feeder to automatically pre-load 
the table with the desired number of sheets. In order to use the Pre Load feature, you must have an MGE i-SF 
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sheet feeder, or an upgraded (with touch screen) MGE 2nd Generation sheet feeder. Older 1st and 2nd Generation 
feeders are incompatible with the Pre Load feature only.

Regmark Search

Regmark Search is used only in conjunction with the vision registration system. The drop-down menu provides
five selections; each one representing a different method of searching for registration marks. 

Manual:  The center of every regmark is defined manually with the crosshair in the Regmark window.

Normal:  i-cut will attempt to automatically find each regmark. If it is unable to locate a mark, you will be 
prompted to manually position the camera over the intended mark.

Extended:  With any of the three extended search methods selected, i-cut will attempt to find the regmarks 
automatically. If it is unable to find either of the first two marks in the copy, it will move the plotter head 
around the expected area in an attempt to automatically find the mark. The size of the area it will search is 
determined by the Extended search option that is selected: Small Area, Medium Area or Large Area. In order 
for the Extended Regmark Search feature to work, you must enter a Regmark size (diameter). i-cut uses the 
Regmark Size to calculate the search area for the selected Extended Search option.

Move Counter

The Move Counter is used estimate the wear incurred by your cutting tools (knife blades/router bits) by tracking 
the distance they have traveled. It allows you to control blade performance and maintain cut edge quality. Blade 
distances are always measured in meters regardless of the selected System Units. They are displayed in the Move 
Counter window, and below the progress bar while the job is running. i-cut allows you to track a total of nineteen 
blades, and up to four at any one time depending on the number of tool positions offered by your cutting device. 
To access the Move Counter window, click Show in the Move Counter section.

Move Counter:  Four Sockets (pen numbers) are available 
in the Move Counter window. The blade i-cut is currently 
tracking for each Socket is displayed in the Name field. To 
select a different blade, chose it from the Socket’s drop-
down menu. The blade’s current meter total is displayed 
in the Counter field. To edit any blade’s parameters, assign 
the blade to a Socket and click Change.

Change:  In the Change window, you are able to enter a 
unique name for each blade, specify a warning distance, and reset the 
meter count. When the meter count exceeds the warning distance a 
warning is displayed below the progress bar, and in the Production 
Manager.

Basic Production Manager

i-cut Provides two options for the appearance of the Production Manager: Advanced, for setting up jobs and 
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Basic, for repeating production. To switch between 
them, click Basic or Advanced (depending on which 
is active). After a job is setup, switch to Basic to run 
additional copies beyond the initial production; while 
concealing the options you don’t want to change. The 
Basic Production Manager is only available for Normal 
production.

Running Jobs

Click Run to begin production. If your job doesn’t contain 
any registration information, it will be sent to your plotter 
immediately. If you are using the vision registration system, 
your cutting device will move the camera to the expected location of the first register mark; taking into account your 
Placement Offset values. If i-cut is able to locate the mark, it will proceed to find the remaining marks and then begin 
producing the job. If i-cut cannot locate the mark, the Regmark window will appear.

RegmarkView

The RegmarkView window is present while i-cut is locating 
registration marks. The graphic in the window represents the 
cut contours and registration marks, with the regmark that i-
cut is currently searching for highlighted in red.

Register Mark

Unless you are repeating production, it is highly likely that 
i-cut will be unable to automatically locate the first register 
mark on the first sheet of your production. Whenever i-cut
is unable to locate any regmark, the Regmark window is 
displayed. From this window you are able to use the mouse, 
or your computer’s arrow keys, to manually position the 
crosshair over the intended regmark. Use the RegmarkView
window to identify the proper regmark. From the Register 
Mark window you are also able to skip the mark, skip the remaining marks on 
the sheet, or manually register any mark that cannot be read by the camera. In 
some situations a mis-registration one regmark will cause i-cut to stop at the 
next regmark. To navigate back (and forth) in such situations, use the Show 
Previous and Show Next buttons.

Progress Bar

The progress bar displays the percentage of the job that has been already sent 
to the cutting device, as well as the meter values for the four Move Counter 
Sockets.
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Jobs Longer than the Table

When running a job longer than the table, i-cut
automatically displays the Long Job window. 
The job is displayed over the table size, which is 
represented by the white section on the left side 
of the window.  The gray area to the right shows 
the portion of the job that exceeds the length 
of the table. Depending on the size of the job, 
i-cut automatically displays one or more vertical 
red lines, which represent how the divisions that 
will be made during production. These lines may 
be re-positioned by dragging them to the left 
or right with the mouse. When using the vision 
registration system, make sure that there are 
enough registration marks printed within each 
divided portion. Positioning the dividing lines just 
to the left of the marks closest to the back of the 
table (within the table limits) will cause i-cut to 
read the same marks before cutting the first and 
second sections. This improves the alignment of 
the cut lines between sections.

Producing Jobs with Barcodes

Printing barcodes on your jobs enhances automated production and improves workflow file management. i-cut supports 
the i-script standard barcode format. To produce jobs with barcodes, click the Barcode tab at the bottom of the Production 
Manager. Doing so will display several options specific to barcode production. Also notice that the Run button graphic 
changes when the barcode tab is selected. Several Production Manager options not applying to barcode production appear 
grayed out.

Barcode

The Barcode section located directly below the Barcode 
tab in the Production Manager provides options which 
define to the type of barcodes you are using, as well as 
how i-cut will read the barcodes.

Type:  Select the type of barcode you are attempting 
to read from the drop-down list.

Direction:  i-script Barcodes should always appear
in the lower left corner of the job. However the 
direction of the barcode, or to which axis of the 
cutting device the barcode is aligned, can be 
changed. The Direction drop-down list allows you 

•

•
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to select the option that best matches the your job. Refer to the graphic next each Direction to make the 
proper selection. In most cases Direction is set to Bottom up.

Manual:  Activating the Manual Barcode check-box will allow you 
to manually enter the barcode information using your computer’s 
keyboard, or a handheld barcode scanner. After you click the Run 
button the Manual Barcode window will appear; providing a text 
field to enter the barcode information. Using a handheld scanner 
will allow you to read poorly printed barcodes on a wider range of 
materials with greater reliability than with the i-cut camera alone. 
You may use any USB or PS/2 compatible barcode reader capable 
of reading the 3-9 barcode format.

Sequence

The Sequence section contains a drop-down list for selecting the production sequence that will take place after 
you click the Run button. You are provided with the following three choices:

Load Job:  Loads the job.

Produce Job:  Loads the job and produces a single copy.

Produce and Continue:  Loads the job and produces multiple copies based on the current option set, and 
reads the barcode on every copy of the production.

When using either the Produce Job or Produce and Continue sequence, a template must be loaded with the job. 
If you are using the Load Job sequence, you may also load a template, or set manually set all cutting parameters 
after the job is loaded. Read the File Path section below for more information on loading templates.

File Path

Open:  The Open path specifies the location i-cut will search for the job defined by the barcode. You may 
type the path in directly, or browse to any accessible folder.

Template:  When the Load Template First checkbox is activated, i-cut
will attempt to load a template with the job. The Template path is used to 
select the specific template (.prm) file that will be used.

Running Jobs with Barcodes

To start a production, create a new file and open the Production Manager. 
After clicking Run, the cutting device will move the camera to the Placement 
Offset location, and the barcode window will appear. The i-script standard 
barcode format is printed with two registration marks. These regmarks provide 
i-cut with the position and rotation of the barcode. Move the camera over the 
first barcode regmark (lower left) and click OK. Depending on the amount 
of rotation, you may need to show the location of the second mark as well. 

•
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The barcode will then be read and the selected Sequence will be executed 
automatically by i-cut.

If i-cut is unable to read the barcode, an error will be displayed. In many cases
the optimal camera settings for reading register marks also work well for reading 
barcodes. If you are unable to consistently read your barcodes, you may need to 
adjust your camera’s F-Stop and Focus settings.

To read barcodes reliably, you must perform a camera offset each time you material 
thickness changes. i-cut must know the distance from the top of the material to the 
camera, which it learns each time a camera offset is performed. Kongsberg users 
do not need to perform these offsets, because Kongsberg cutting devices maintain a consistent height above the 
material surface. Kongsberg users should however, press the Tool Down button before reading the first barcode 
regmark on the first copy. Doing so will properly set the initial camera height.

Check Barcode

The Check Barcode feature, located in the Calibration menu 
should be used to identify problems with barcode reading 
and make adjustments to the camera settings. Clicking 
Check Barcode opens the Check Barcode window, which 
displays a live video image from the camera. Use your 
computer’s keyboard to move the camera over a barcode. 
Use the Vertical checkbox to tell i-cut whether the barcode 
appears vertical or horizontal (unchecked) in the window. 
The blue lines define the areas i-cut recognizes as bars. As 
you adjust your camera settings, notice how these lines 
fluctuate. The goal is to reduce this fluctuation as much as 
possible and produce stable blue lines defining each bar.

Producing Jobs with Edge Recognition

Edge Recognition provides the ability to register cut paths to the
edges of your material. i-cut is able to adjust the position and 
rotation (up to 15°) of a job based on the position and rotation 
of the material on the plotter bed. This feature is extremely 
valuable for producing jobs that must be cut or creased from 
the back, as well as jobs produced from un-printed materials. 
You may even use edge recognition for jobs that have been 
printed without register marks, depending on your required 
cutting tolerance. To use Edge Recognition, select the Edge 
Recognition tab at the bottom of the Production Manager. As 
with barcode, the run button graphic will change to reflect the 
current mode.
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Sensor Type:  Sensor type indicates the Edge Recognition method you would like to use. You are able to choose i-cut
Camera or Zünd Edge Sensor. Both methods work in a similar manner. The Zünd Edge Sensor is an optional item 
that may be added to a Zünd cutting plotter. If your i-cut product supports vision registration, the i-cut camera may 
be used with Zünd plotters, as well as all other i-cut supported cutting systems. Select the method you would like to 
use.

Sheet Position:  The X and Y values in the Sheet Position section represent the position of the lower left corner of 
your material on the plotter bed. Initial values may be manually entered in these two fields, but they will be updated 
automatically after the first copy is produced. Notice that in Normal production, this duty is assigned to the Offset 
values in the Placement section. When using edge recognition, the Placement Offset values represent the distance 
from the edges of your material to your cut path(s). For example, if you wanted to produce a rectangle 1” from the 
lower left corner of your material, you would manually enter 1” in both the X and Y Offset fields in the Placement 
section.

Check Edges:  This feature defines the check edge distance from the corner of the sheet. During production the
camera or edge sensor will move the input distance away from the sheet position in X and Y and attempt to locate 
the edges of the material. The greater distance, the more accurately i-cut will be able to compensate for material 
rotation.

Edge Sensor Offset

If you are using the Zünd Edge Sensor, you must calibrate it 
by manually entering Offset values in the Edge Sensor Offset 
window. This window is accessible from the Calibration 
menu.

Check Edge Recognition

You may need to make adjustments to the i-cut camera’s F-
Stop and Focus when using edge recognition. The Calibration 
menu provides access to the Check Edge Recognition window, 
which will assist you in making these adjustments. i-cut uses 
contrast to define the edges of your material. As with reading 
register marks, the most accurate registration comes from the 
best contrast provided by the camera.

To use the Check Edge Recognition window, position the 
camera over the edge of the material. Activate the Vertical 
checkbox if the edge appears vertical in the window. If the edge 
appears horizontal, leave the box unchecked. When there is sufficient contrast, a blue line will define the material’s 
edge. If no blue line appears, or if the line is fluctuating and unstable, adjust your F-Stop and Focus for a better 
result. Some materials that are close to the same color or shade as your cutting surface may not yield sufficient 
contrast for recognizing edges.

•

•

•
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Running Edge Recognition Jobs

When you click the Run button with the Edge Recognition tab activated i-cut will attempt to produce the job 
using edge recognition. The Edge Recognition window will appear and the plotter head will move to the location 
specified in the Sheet Position section. For the first copy of every production, the camera or sensor must be 
manually positioned over the lower left corner of the material. i-cut will attempt to automatically find the corner 
for every additional copy in the production. The plotter will then find two edges of the material at the Distance 
from Corner set in the Check Edges section. If your material is rotated in excess of 15°, or if your camera or sensor 
isn’t properly calibrated, i-cut may not be able to locate an edge. When this occurs, an error is produced.

Distortion Reporting

i-cut is able to record and display distortion statistics 
from recently run productions. To view these statistics, 
select Distortion Info... from the File menu. This opens 
the Distortion in Last Production window, which 
contains the following information:

Distortion in recent jobs:  Displays the recorded 
Linear and Non-Linear distortions from your Last 
10 productions, as well as a date and time for each 
production.

All Time Highest Distortion:  Displays the worst 
Linear and Non-Linear distortions ever recorded 
by your system, as well as the dates and times they 
were recorded.

Save Excel File in:  Allows you to set a file path
for the full distortion report, which is generated for 
each production. This full report contains much 
more information than is displayed in the window, 
including values for each registration mark read by 
i-cut.

In addition, i-cut continually displays the most current distortion values in the Progress window, so you can track you 
job’s distortion during production.

•

•

•
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Advanced Production Setup

Editing the standard Production Options and tools provides unlimited possibilities for custom production. In most cases 
one of the standard options or tools is the best choice, however i-cut provides complete control over them to ensure that 
you will be able to achieve the highest productivity in any situation.

Editing Production Options

All advanced editing of production options is conducted in the 
Production Settings window. Click Edit in the Production Options 
window to open the Production Settings window.

String to Send

The String to Send section displays the HPGL, G-Code and 
i-cut commands that will be sent to the plotter; divided into 
four lines that dictate when the commands will be sent; in the 
production sequence.

Before First table:  Sent before production begins, before the first table is produced.

After tables:  Sent after each table, apart from last.

Before tables:  Sent before each table, apart from first.

After Last table:  Sent after the last table has been produced, at the very end of the job.

Commands

A list of system specific commands is accessible from the button to the right of each command line. The list 
provides the most common available commands for your system. Selecting a command from the list will 
automatically insert it at the end of the respective command line. Refer to the reference part of this manual for 
printed lists of provided commands.

Feed After Table

Activating this box advances the material after each table. The feed length is calculated using the size of the job. 
If the job contains registration marks, i-cut automatically feeds the job to the front of the table after the second 
copy, preventing it from tracking back on the table. Feed After Table is normally used only with roll feeding.

Track Increasing Deviation

Track Increasing Deviation allows to i-cut to update the Placement Offset values continuously. This option is 
used most often with roll fed jobs, because the rolls often track back and forth during production. It can also be 
used with sheet fed jobs to help track an uneven stack of material. If the job is not positioned consistently on the 
cutting surface, the offset value will be updated multiple times without restarting the production.

•

•
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Advanced Tool Setup

The Edit Tools window also contains a String to Send 
section. The button to the right of each command line 
provides access to the same commands available for 
Production Options. The tools string is also divided into 
four sections. Adding commands to the string allows you 
to customize tools for your specific production needs, 
and control additional too parameters not present in the 
standard Generate Code for section of the Edit Tools 
window.

Before Layer:  Sent before each layer.

After Layer:  Sent after each layer.

Before each Curve:  Sent before each curve.

After each Curve:  Sent after each curve.

Advanced Kongsberg Production Features

Kongsberg Toolbar

The Kongsberg menu and toolbar provide direct access to several important XL/XE-Guide features. Using these 
features will allow you to operate your system directly from i-cut, without having to open XL/XE-Guide.

Vacuum Zones:  Selecting this option opens the Vacuum 
Zones window, which allows you to turn on/off your 
table’s individual vacuum zones. Closing vacuum zones 
which are not covered by the material you are cutting will 
increase the vacuum hold-down strength in the zones you 
are using.

Tabletop Reference:  When selected, Tabletop Reference 
will force the cutting table to measure the height of the 
table. All tool height adjustments are automatically offset 
to account for the new table height. You should perform 
a Tabletop Reference whenever the height of your cutting 
surface changes. For example, when you add or remove a 
cutting underlay.

Reference Point Selection:  Allows you to toggle between your table’s standard (1) and variable (X) reference 
points. The standard reference point is automatically selected when you run a job with registration marks.

Tool Setup:  Provides access to the Kongsberg Tool Configuration window and allows you to modify the 
configuration of individual tools. For more information on Kongsberg tool configuration, refer to the 
Configuration part of this manual.

•
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Tool Depth Setup:  Provides access to only the Tool Depth setting for individual tools. Using this option 
reduces the time needed to set tool depth and prevents accidental modification of other tool configuration 
parameters.

Show XL/XE-Guide:  Selecting this option will show or hide XL/XE-Guide. Do not close XL/XE-Guide 
when you want to hide it, be sure you instead use this feature.

Reset Surface Detection:  By selecting this option, you reset the height of the toolhead to the uppermost 
position. Kongsberg cutting systems automatically maintain the height of the toolhead above the surface 
of the material the are cutting. In order to do so, the system must measure the height of new materials. As 
a result, it is possible to break long router bits and blades when switching from a thin material to a thick 
material, because the system could run the blade or bit into the side of the thick material before it has had a 
chance to measure the height of the material. Using this option when switching from thin to thick materials 
eliminates this possibility.

Tool Offset:  This feature improves the offset between tools by using the i-cut vision registration system to 
modify XL/XE-Guide’s tool offset values. The procedure is exactly the same as a Camera Offset. After you 
completed the initial setup of all your Kongsberg tools, perform the offset with each tool.

Optimization

XL/XE-Guide provides several options in the Optimization section of the System Options window. These settings 
control cutting quality, processing speed and more. To access these settings, select Show XL/XE-Guide from the 
Kongsberg menu, or click the corresponding button on the Kongsberg toolbar. When XL/XE-Guide appears, 
select System option... from the Options menu.

Sequencing:  XL/XE-Guide determines the sequence in which curves will 
be produced. This option is not necessary when using with i-cut, because 
all sequencing is performed before the job is sent to XL/XE-Guide.

Optimize tool use:  XL/XE-Guide attempts to improve processing time 
when multiple tools are used in a single production. This option is not 
recommended when using i-cut, because it overrides the processing order 
of layers.

Check for critical geometry:  XL/XE-Guide will attempt to reduce lifting 
of through cut materials by forcing the table to only cut into sharp angles. 
Using this feature produces double overcuts in sharp angles.

Remove double cuts:  XL/XE-Guide automatically removes double cuts 

when producing.

Cutting Quality:  Selecting a cutting quality from the drop-down box 
automatically adjusts Line to circle tolerance, and modifies machine 
acceleration to produce the desired quality. When kiss cutting with an i-
XL system, Cutting Quality should be set to High.

•
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Knife lift angle:  Sets the angle at which the knife will lift when producing. 
This value is over-written by the Tool-up parameter in i-cut.

Line to circle tolerance:  This parameter is set automatically by the 
Cutting Quality selections. We do not recommend modifying it manually. 
Changing the value affects system performance.

Conveyor Belt

The belt section in XL/XE-Guide’s Speed setup window allows control of 
conveyor belt Speed and Acceleration. To change the default values, Show 
XL/XE-Guide and select System Option... from the Options menu. Click the 
Speed setup tab at the top to open the Speed setup window. Modify the Speed 
and Acceleration parameters by entering a percentage of maximum. It may 
be necessary to reduce the conveying speed when attempting to feed heavy 
materials, or when you have multiple copies on the table at one time.

Using the Short Foam Knife

Your Kongsberg cutting system is capable of cutting materials up to 1”(25mm) 
thick using the Heavy-Duty Vibrating Knife. In order to cut materials 
0.75”(19mm) and thicker with the knife, you are required to 
follow this special procedure:

Insert the tool into the first tool position (furthest left) in 
your MultiCUT head.

Open the Kongsberg Tool Configuration and click More.

Activate Ignore the automatic tool identification and click OK
to return to the Configuration window.

Select Short Foam Knife from the drop-down box above the 
first tool position.

Don’t forget to re-calibrate your tool height, and to use Reset Surface Detection 
to reset the height of the toolhead. When you have finished cutting the thick 
materials, be sure to de-activate the Ignore the automatic tool identification 
option in the Kongsberg Tool Configuration More window.

Applying Glue Lines

Applied glue lines are normally used in conjunction with the optional i-cut Auto-Weeding waste removal system for vinyl 
graphics. The Glue Line window is accessed from the Preparation menu, and is only available if the Auto-Weeding system 
or a stand-alone glue system has been purchased, and the glue line option has been activated.

The parameters set in the Glue Line window are used by i-cut to generate lines for glue application; based on your 

•
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selected curves. The lines are processed by the plotter, 
which precisely applies glue (using the installed glue 
system) to the waste areas of your material. When that 
material passes through the Auto-Weeding system, the 
waste adheres to a removal film, and is automatically 
weeded away from the material. To achieve consistently 
successful weeding, your glue must be applied to the 
proper areas. Glue lines can only be applied to closed 
shapes.

Layer:  Selects the layer in which the glue lines will 
appear. Glue lines must always reside on their own 
layer(s); this avoids confusion and allows assigning 
of a specific tool for glue line application.

Depends on Curve Direction:  Depends on Curve 
Direction defines how i-cut will interpret selected 
curves to generate glue lines. If it is checked, 
glue lines will be generated to the left or right 
of the curves’ cutting direction, similar to tool 
compensation. If it is unchecked, the outermost 
selected curve of a nested group is assumed to 
define the outside shape or waste area, depending 
on whether or not you are generating a weeding 
frame. Curves nested inside the shape are correspondingly 
interpreted as inside shapes or waste areas. Remember that glue 
lines can only be applied to closed shapes.

Glue Line Offset:  Defines the offset distance from the selected 
curve to the glue line.

Angle Gap:  Provides a simple and efficient way of controlling 
the amount of glue applied to the job. The value represents the 
angle of divergence from 0°. The higher the value, the more glue will be applied.

Min. Size:  This parameter specifies the minimum glue line length and provides another way to control the amount
of glue applied to the job.

Add Weeding frame:  When checked, this feature provides an outside frame for removing waste around selected 
curves. The parameters associated with the weeding frame control the frame’s distance from the curves, size and 
spacing of weeding tabs (for lifting the front edge) and whether the frame is complete or partial. A partial frame is 
used to weed the waste material off the entire liner. Spike width defines the length of the cut lines that extend from 
the front edge off the sheet.

To improve automatic weeding results, it is often necessary to make adjustments to the glue lines generated by i-cut. It is 
a good idea to add a few glue lines that run the entire length of the sheet. Doing so will help to adhere large waste areas to 
the remover film and stabilize the sheet as it passes through the Auto-Weeding system. 3/4 circles can also be drawn around 

•
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sharp points to prevent them from lifting during weeding. Another useful technique for improving weeding results is 
rotating the job before applying glue lines. Certain shapes may weed better depending on which way they are facing when 
they pass through the Auto Weeding system.

i-cut usually generates more glue lines than are required. Removing some of these extra lines will decrease the time it takes 
to apply glue to the job. Precisely applied glue is only necessary in the areas where the waste is lifted from the material. 
Use i-cut’s curve editing features to make the adjustments to your glue lines. Every time glue lines are generated, a Helper 
layer is also generated. It contains the weeding frame, as well as any 3/4 circles that may have been created automatically. 
The contents of the Helper layer must be cut. They can be transferred to another layer, or the Helper layer can be prepared 
for cutting.
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Reference

Keyboard Shortcuts
CTRL + N New File
CTRL + O Open File
CTRL + I Import File
CTRL + S Save File
CTRL + Shift + S Save As
CTRL + + Zoom In
CTRL + - Zoom Out
CTRL + 0 Fit to Data
CTRL + P Print
CTRL + R Production Manager
CTRL + A Select all Layers
CTRL + D Deselect all Layers
CTRL + Shift + A Select all Curves
CTRL + Shift + D Deselect all Curves
CTRL + U Remove Unused Layers
Delete Remove Curves

Kongsberg Toolbar Buttons

Vacuum Zones

Reference Point Selection

Table Top Reference

Reset Surface Detection

Tool Height Calibration

Tool Calibration

Show/Hide XL/XE-Guide
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Standard Toolbar Buttons

New File

Open

Import

i-cut Text (option)

Save

Undo

Zoom In

Zoom Out

Zoom Window

Fit to Data

Show/Hide Curve Direction(s)

Show/Hide Points

Show/Hide Tool Path(s)

Toggle On/Off Edit Points Mode

Optimize Curves

Open Production Manager

Print

About i-cut

Check for Updates (web connection required)



61
i-cut 6.2 USER’S MANUAL

Layers Palette Buttons

Select all Layers

Deselect all Layers

Add Layer

Remove Layer(s)

Copy Layer(s)

Copy Layer(s) with Curves

Universal i-cut Commands

Command Name Function
I-MS Please Replace Material Message + message text Displays a message
I-PK Park Parks the cutting head
I-FF Feed Feeds using conveying system
I-LS Load Sheet Loads a sheet using i-SF feeder
I-FM 1 Sheet Feeder Communication Turns communication on
I-FM 0 Sheet Feeder Communication Turns communication off

I-SD5000 Delay + time in ms Inserts delay time between com-
mands

I-DS 3,2 Dash + length,gap in mm Cuts dashed lines, sets Length, Gap

Kongsberg Commands

Command Name Function
%%PMPon Pump On Turns on vacuum pump
%%PMPoff Pump Off Turns off vacuum pump
%%SUCon Blowback Off Turns off blowback
%%SUCoff Blowback On Turns on blowback
%%SSA 50,50 Conveyor Movement + values in % Sets Speed, Acceleration values
L:4 P:3 Glue Module Control (XE only) Sets Length, Pulse values
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Mecanumeric Lasec Commands

Command Name Function
$Replace Material%nM0 Message + message text Displays a message
M200 Fume Extractor On Turns on fume extractor vacuum
M201 Fume Extractor Off Turns off fume extractor vacuum
M3 Shutter Open Opens Shutter
M5 Shutter Closed Closes Shutter

Mecanumeric Pro Commands

Command Name Function
$Replace Material%nM0 Message + message text Displays a message
M200 Vacuum On Turns on vacuum pump
M201 Vacuum Off Turns off vacuum pump
M251 Camera Down Lowers camera
M252 Camera Up Raises camera
M3 Spindle Start Turns on spindle
M5 Spindle Stop Turns off spindle
M51 Waste Extraction Down Lowers waste extraction device
M50 Waste Extraction Up Raises waste extraction device
M202 Waste  Extraction On Turns on waste extraction vacuum
m203 Waste Extraction Off Turns off waste extraction vacuum
G0 Z50 Z Position + value in mm Sets Z position

MultiCAM Commands

Command Name Function
SP0 Flush Clears machine memory buffer

ZO 147,1 X-Max + coordinates Moves machine to Max X coordi-
nate

Zund Commands

Command Name Function

PS 0,1;SD 50;PS 0,0 Two Wire Mode Sheet Feeder Double blowback for two-wire feed-
ers
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Zund Commands

Command Name Function
TR 0 Rotation Off Turns off tool rotation
TR 1 Rotation On Turns on tool rotation
AU 45 Pen Up Angle + value in degrees Sets pen up lift angle
PB 2,1 Pump On Turns on vacuum pump
PB 2,0 Pump Off Turns off vacuum pump
PS 1,1 Vacuum On Turns off blowback
PS 1,0 Blowback Turns on blowback
SV 50000 Vacuum Width + value in 1/100 mm Sets  vacuum width
NR Offline Turns machine offline
FL 100000;FF Feed + value in 1/100 mm Sets Feed Length, Feeds conveyor
FC Foil Cut Cuts across front of plotter bed
PU 100000,100000 Park + x,y values in 1/100 mm Parks cutting head at X,Y
SD 500 Delay + time in 1/100 seconds Inserts a delay time
SJ 1 Select Job + job number Selects a job

EG 1 External Gas On Turns on external gas (Eurolaser 
only)

EG 0 External Gas Off Turns off external gas (Eurolaser 
only)

FO 1 Feeder On Turns on feeder (Wild only)
FO 0 Feeder Off Turns off feeder (Wild only)




